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Using Windows Programs

Student Resources labyrinthelab.com/esl4

 
L E A R N I N G  O B J E C T I V E S

Computer Objectives
■	 Use a program menu

■	 Use a program Ribbon

■	 Open a dialog box and work with a 
drop-down list

■	 Draw a picture in the Paint program

■	 Use the Calculator program

■	 Play a computer game

Language Objectives
■	 Use vocabulary words to describe parts 

of different programs

■	 Use computer verbs to describe actions 
you can do with different programs

■	 Talk with a partner about drawing a picture 
in the Paint program

■	 Talk with a partner about the different kinds 
of things you can do with programsEVALU
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34 Chapter 3  |  Using Windows Programs

 Vocabulary

Picture Dictionary — Nouns
A noun is the name of a person, place, or thing.  
The following nouns are introduced in this chapter:

1.	 Dialog box – A window with boxes you 
can click to select what you want

2.	 Checkbox – A box that you can click to 
select an option you want

3.	 Drop-down list arrow – An arrow you 
can click to make the drop-down list 
box appear

4.	 Drop-down list box – A list with options 
you can choose from
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Vocabulary 35    

5.	 Hardware – The physical part of the 
computer system, such as the monitor 
or the keyboard

6.	 Software – Programs added to the 
computer system that are not 
hardware, such as WordPad

7.	 Appearance – The way an object 
looks, such as on the computer screen.

The word “appearance” is a noun. The word “appear” is a verb.

8.	 Settings – Information about how a 
program is set up

9.	 Program menu button – Button you 
click in WordPad and Paint to show 
new choices

NOTE!
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 Vocabulary  (continued)

Computer Verbs
A verb tells an action or what a subject is or does. The following verbs are introduced in this 
chapter:

VERB MEANING EXAMPLE

1.	 Appear When something shows and 
you can see it

When you click the box, a checkmark 
will appear inside the box.

2.	 Check To click a box so that a 
checkmark appears

When you have a few choices, you 
must check the one that you want.

3.	 Clear  
(a box)

To click a button or box to 
remove what you checked 
before; to uncheck a box

I changed my mind, so I have to clear 
the box that I checked before.

4.	 Release  
(a button)

To take your finger off the 
mouse button

After you finish your mouse action, 
you should release the mouse 
button.

5.	 Let up To release or let go of the button Another way to say “release the 
mouse button” is to say “let up on 
the mouse button.”

“Release” and “Let up” are synonyms. Synonyms are words that have the same or 

similar meaning.

6.	 Play To use a computer game I like to play Solitaire and other card 
games on my computer.

7.	 Preview To see how information will look 
when it is printed so you can 
decide what you want to do

I want to preview how the document 
will look before I print it.

8.	 Hold  
(a button)

To keep your finger pressed on 
the mouse button

Sometimes you have to hold down 
your mouse button for a few 
seconds, and sometimes you only 
have to tap it.

9.	 View To look at something It is important to view the tools on 
the toolbar so you can see the 
options.

NOTE!
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 Concepts and Exercises

3.1	 Common Features in Programs
A program is a set of directions that tells the computer exactly what to do to get a 
certain kind of job done. Not all programs look the same.

Here are examples of kinds of programs that do different jobs:

 
A word-processing program is used to 
type text.

A spreadsheet program is used mostly 
for numbers.

A graphics program is used to 
make and change pictures.

A web browser is used to find things on the 
Internet.

A computer game is used to 
relax and have fun. A tutorial is used to show and teach ideas.
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38 Chapter 3  |  Using Windows Programs

Different programs have many parts that are the same. Most program windows have 
the following parts:

A second example of a program is Paint.

WordPad program window

	A	Title bar – Tells you the 
program you are using

	B	Ribbon – A bar with different 
buttons; each one does a 
different job when you click it

	C	Buttons – Icons that do 
different jobs when you click 
them with the mouse

	D	Work area – The place where 
your work shows

Paint program window

	A	Title bar – Tells you the 
program you are using

	B	Ribbon – A bar with different 
buttons; each one does a 
different job when you click it

	C	Buttons – Icons that do 
different jobs when you click 
them with the mouse

	D	Work area – The place where 
your work shows
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 Concepts and Exercises 39    

⊲⊲ Open the WordPad Program

In this exercise, you will use the Start button to start the WordPad program. Every 

computer with Windows has this program.

	 1.	 Open WordPad: Start→All Programs→Accessories→WordPad.

	2.	 Click the Maximize  button to make the WordPad window fill the screen.

	3.	 Find the title bar on the screen and point at it with the mouse. 

	4.	 Find the Ribbon and the work area. Move your mouse pointer over each part.

Leave WordPad open for the next exercise.
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3.2	 Dialog Boxes
Most programs have some type of dialog box. You can change settings by changing 
the information in a dialog box. Many dialog boxes have the following features:

WordPad program dialog box

	A	Checkboxes – Click in the 
boxes to check or uncheck 
them.

	B	Drop-down list arrow – An 
arrow that points down and 
that you can click to open a 
drop-down list.

	C	Drop-down list box – A list 
of choices that opens when 
you click on the drop-down 
arrow.
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⊲⊲ Open a Dialog Box

In this exercise, you will use a dialog box in WordPad. The program should be open 

from the last exercise.

This dialog box will appear on your screen.

	3.	 Find a drop-down arrow, a drop-down list box, and a checkbox.

	4.	 Close the dialog box with the Close  button. Then, close WordPad.

	1.	 Click the program menu 
button.

	2.	 Choose Page Setup.
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3.3	 Using Tools on a Ribbon in Paint
Paint gives you many tools to work with to make pictures. Some are easy to use and 
some take a while to learn. We will look at the easy ones now.

■■ You can use tools on a Ribbon by clicking on them.

■■ In Paint, when you click on a tool, a special symbol appears in place of the mouse 
pointer. Each tool has its own symbol.

We will not use all the tools, but only a few to see how they work. Here are some of the 
tools. To use a tool, click it.

Tools only work in the white area of the Paint window. If you want to pick a color, click 
on one of the colors on right side of the Home tab of the Ribbon.

	A	Pencil

	B	Eraser 	C	Paintbrush 	D	Line tool

Paint colors
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Dragging
To use a tool, you need to drag with the mouse. (For a definition of “drag,” see 
Chapter 1, Learning About Computer Basics.) Here is how: 

1.	 Point where you want to start and then hold down your left mouse button.

2.	 Move the mouse to make your design.

3.	 Let go of the left mouse button when you are finished making the design.

You will learn how to drag in the next exercise. 

⊲⊲ Use Tools in Paint

In this exercise, you will use some of the drawing tools in Paint. The program 

should still be open from the last exercise.

	 1.	 Open Paint: Start→All Programs→Accessories→Paint.

Draw a Line

	2.	 Maximize  the Paint window.

	3.	 Click the Line  button on the Ribbon. 

	4.	 Point to a place on the left side of the white area.  

Hold down your left mouse button, and keep it held down until step 6.

	5.	 Move the mouse to the right. 
This draws a line.

	6.	 Let go of the mouse button 

where you want to stop the line.

You should see a line.
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Draw a Box

	7.	 Click the Rectangle tool.

	8.	 Point to a place anywhere on the white 

area. Hold down the mouse button and 

move it in the direction shown while 

keeping the button held down.

9. � Let go of the mouse button.
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Draw a Colored Line

	10.	Click the Pencil tool. 	11.	Click the color red from the 

Colors box.

	12.	Point to a place anywhere on the white area. 

Hold down your left mouse button and then 

move the mouse up and down and to the right 

to paint a curving line.

13. � Let go of the mouse button.

	14.	If you make a mistake, you can erase it with the Eraser.

	15.	You can keep drawing to add anything else you like to your picture.

	16.	When you are finished, close Paint.
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3.4	 The Windows Calculator
The Calculator is another useful program on the computer. You can use it to do many 
calculations. The program looks just like a regular handheld calculator and works the 
same way. You can type numbers, or you can click the number buttons.

HOW TO USE THE CALCULATOR

Open the Calculator program: Start→All Programs→Accessories→Calculator.

Examples of the four basic operations:

Add Two Numbers

A.	 Click the first number.

B.	 Click the plus ( + ) sign.

C.	 Click the second number.

D.	 Then click the equal ( = ) sign.

Subtract Two Numbers

A.	 Click the first number.

B.	 Click the minus ( – ) sign.

C.	 Click the second number. 

D.	 Then click the equal ( = ) sign.

Multiply Two Numbers

Use the * button: (3 * 2 = 6).

Divide Two Numbers

Use the / button: (8 / 2 = 4).
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⊲⊲ Use the Calculator

In this exercise, you will use the Calculator to add and subtract. You do not have to 

type in the numbers. Just click the number buttons with your mouse.

	 1.	 Open the Calculator: Start→All Programs→Accessories→Calculator.

Add Two Numbers

	5.	 Click the 3 button  

two times for 33.

You can see the answer (55) in the number box.

	7.	 Click the C button to clear the Calculator.

2. � Click the 2 button 

two times for 22.
	3.	 See the number in 

the number box.

	4.	 Click the plus sign 

to add the next 

number.

	6.	 Click the equal 
sign (=) to finish.
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Do Other Calculations

Press C to clear after you complete each of the calculations in 
steps 8–11.

	8.	 Click these buttons on the calculator: 12 + 6 = 

	9.	 Click these buttons: 100 + 75 = 

	10.	Click these buttons: 50 – 10 = 

	11.	Click these buttons: 389 – 14 = 

	12.	When you are finished, close Calculator.

3.5	 Using a Menu
Once you have had some practice using menus, you will find that they are easy to use. 
The way they work is the same from one program to the next. What changes in each 
program is the list of choices in the menu.

■■ You can open a menu by clicking on one of the words.

■■ Each word has its own menu that opens separately.

■■ When you click on some of the menu items, a dialog box will open.

Calculator’s View menu opens when 
you click View on the menu bar.

The Calculator’s Help menu 
opens when you click Help on 
the menu bar.
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⊲⊲ Use a Menu

In this exercise, you will use a menu. Many settings can only be changed by using 

menus.

	 1.	 Click View on the menu bar. Keep your mouse over the View menu item.

	2.	 Click Scientific. 

The Calculator now shows the Scientific view with more advanced buttons.
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	3.	 Click View, and then click Standard to return the Calculator to normal. 

	4.	 Close  the Calculator.
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 Skill Builder Exercises 

3.1	 Use Paint

In earlier exercises, you tried some Paint tools. In this exercise, you will create a real 

drawing.

	 1.	 Open Paint: Start→All Programs→Accessories→Paint.

	2.	 Maximize  the Paint window.

	3.	 Use some of the tools and colors to draw a picture of a house. 

The house doesn’t have to look perfect. This is just to practice using the mouse and 

dragging to draw. Many programs let you do this. 

	4.	 When you are finished, Close  Paint.

	5.	 If Paint asks you if you want to save your work, click No. 

If you already know how to save a file, click Yes and give the file a name.

You will learn how to save your files in Chapter 5, Doing More with WordPad.NOTE!EVALU
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3.2	 Use the Calculator

In this exercise, you will use the Calculator program to multiply, divide, and 

subtract numbers.

	 1.	 Open Calculator: Start→All Programs→Accessories→Calculator.

	2.	 To multiply, press these buttons: 3 x 12 = 

	3.	 To multiply, press these buttons: 25 x 2 = 

	4.	 To divide, press these buttons: 80 / 4 = 

	5.	 To divide, press these buttons: 36 / 12 = 

	6.	 To subtract, press these buttons: 99 – 43 = 

	7.	 To subtract, press these buttons: 52 – 12 = 

	8.	 When you are finished, close Calculator.
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3.3	 Play a Game

In this exercise, you will learn to play Solitaire. If you have never played Solitaire 

with cards, ask a friend or your teacher to explain how to play the game. Playing 

this game will give you good practice using the mouse.

	 1.	 Open Solitaire: Start→All Programs→Games→Solitaire.

	2.	 To move one of the cards, click on it. Hold down the mouse button and drag it 

to a new place. If you put a card in the wrong place, it will not stay there. It will 

jump back to where it was.

	5.	 If you want to start a new game, click Game→New Game.

	6.	 When you are finished playing, click the Close  button.

	3.	 When you want to turn over a new card, click on the pack at the top.

	4.	 Start putting the aces in the four shaded areas, and build up from there. 

The suits (pictures on the cards) must match in each top pile. You must 

put all the cards in the top piles in order to win.

EVALU
ATIO

N O
NLY

PRE-PUBLICATION MATERIAL For review only. Not for sale or classroom use.

© 2016 Labyrinth Learning   http://www.lablearning.com



54 Chapter 3  |  Using Windows Programs

3.4	 Personal Project: Draw a Map

In this exercise, you will draw and print a simple map with the Paint program.

	 1.	 Open Paint: Start→All Programs→Accessories→Paint.

	2.	 Draw lines to create a simple street map of the area around your house.

To draw straight lines, hold down the [Shift] key as you drag a new line. 

	3.	 Use the Text  tool to add street names. Click near where you want to type the 

words. Hold down the mouse button and drag a text box. Then you can type a 

street name inside the box. Make a new box for each name.

	4.	 To print the map, click the program menu button , click Print, and then 

click Print again.

	5.	 Close Paint without saving the map. (Or, if you know how to save a file, use 

File→Save As to save it.)

TIP!
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 Paired Conversation 

With a partner, take turns reading the A and B parts of the conversation.

Student A Yesterday we learned how to minimize a window.

Student B Yes, I remember. The window disappeared but did not really close.

Student A Do you remember how to maximize a window?

Student B Yes. Now let’s talk about what we learned today.

Student A Today we learned about hardware.

Student B Is that like the computer and the monitor?

Student A Right. We also learned about software.

Student B That’s like WordPad and Paint that are added into the computer.

Student A That’s true.

Student B We also learned about the dialog boxes.

Student A Yes. Dialog boxes are important because they let you select the settings that you want.

Student B Did you play a computer game today?

Student A Not really. I just watched somebody else play.

Student B We did practice using the Paint program.

Student A I liked drawing a map and typing the names of the streets.

Student B Well, I’m so glad we are learning so much!
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